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Using Excel

Basics

Introduction

Excel for Windows is a spreadsheet application that allows you to organize numerical data in many ways. Data is entered electronically, and can be manipulated using a variety of general, financial, and mathematical tools XE "mathematical tools" . A spreadsheet can be set up so that changing one number changes all sorts of related functions. Excel organizes its spreadsheets by creating Workbooks, each containing sixteen spreadsheets.

In addition to Excel’s powerful spreadsheets, the program contains tools to create and modify virtually every kind of chart XE "chart" : line, bar XE "bar" , area XE "area" , pie XE "pie" , or XY graph XE "XY graph" . Charts can be 3-D XE "3-D"  or 2-D, and can be modified just about every way you might want.

Advanced functions in Excel include tools to use a spreadsheet as a database XE "database" , including sorting and extracting data, and importing and exporting data to and from other PC’s or mainframe databases.

Using Shortcut Menus XE "Shortcut Menus"  (Word, PowerPoint, Excel)

Word, Excel, and PowerPoint all have Shortcut Menus XE "Shortcut Menus" . These menus appear when you click on any part of the screen with the right side of the mouse. Shortcut Menus XE "Menus"  contain commands related to the item you’ve pointed to. They save time, because you don’t have to search to find the command you want.

Menus XE "Menus" , Toolbars XE "Toolbars" , and Keyboard Commands XE "Keyboard Commands" 
Word, Excel, and PowerPoint all allow you to use at least three kinds of commands. Each has a Menu Bar XE "Menu Bar"  at the top of the screen, which allows you to click on the command and get a Pull-Down Menu. The Toolbars XE "Toolbars"  are the bars underneath the Menu Bar, full of Toolbar buttons that perform a variety of tasks. You can open several toolbars, and you can customize toolbars to suit your needs. You can also use a variety of keyboard commands. For the most part they do the same thing, but there are several occasions when using the Menu commands is best, such as printing. This is because the Menu commands are the only way you can get a list of options.

Navigating XE "Navigating"  A Workbook

The default workbook, which you get whenever you open a new Excel spreadsheet, holds a total of 3 worksheets. However, you can add more, to a total of 255 worksheets (which is probably more than your computer can handle anyway!) Each worksheet has horizontal rows XE "rows"  and vertical columns. The columns are numbered from A to Z, and then go to AA, AB. etc., all the way to IV. The rows are numbered from 1 to 65536. This means each worksheet can have as many as almost 17 million cells! (16,777,216, but who’s counting?!) Here are some tips for getting around on the spreadsheet:

· Click on Go To in the Edit Menu, or press F5, to display the Go To dialog box. Type in the address you want and press Enter.

· Press Cntl and Home to return to A1 (“home” from anywhere else.)

· Press Control and End to go to the end of the data you are working on.

· Press Control and the left arrow to go all the way to the left of the Spreadsheet, right arrow to go all the way to the right, down arrow to go all the way to the bottom, and up arrow to go all the way to the top.

· The arrows on the numeric keypad will work the same way if you turn the Num Lock XE "Num Lock"  off.

· Press Enter to move down one cell, and Tab to move right one cell. Shift and Enter move you up one, and Shift and Tab move you one cell to the left.

Moving XE "Moving"  From One Spreadsheet to Another

· The tab scrolling buttons at the bottom left-hand side of the screen move you quickly from one worksheet to another. The left arrow moves left, and the right arrow moves you right. The arrows with the lines move you to the last or first spreadsheet.

· Clicking on the tabs on the bottom move you from a worksheet to the one you click. Clicking twice brings up a dialog box that allows you to change the name of the sheet.

The Cell XE "Cell" : Basic Unit of A Spreadsheet

Cells in a spreadsheet are numbered by both the row and column labels. For instance, a cell in column B, and in row 3, is known as B3.

Every action in Excel requires selecting one or more cells. To do this, you click and drag in a variety of ways.

· If you click on a cell, it is activated, and you’ll see a black box with a tiny square in the lower right-hand corner. This is the AutoFill XE "AutoFill"  Box. More on that shortly.

· To deselect any cell, click on any other cell.

Selecting Multiple Cells XE "Multiple Cells"  

· When you click on a cell and then drag it to another cell, you will activate all the cells that are highlighted. You can also click on one cell, then hold down the Shift key and click on another one, and all the intervening cells will be activated.

· To deselect a range, click on any cell.

· To select the whole worksheet, click on the Select All button, the gray button on the top left corner of the spreadsheet.

· To select two separate ranges of cells, first select one, then press the Control key, and select the next one.

The Undo XE "Undo"  Button

If you realize you have made a mistake, press the Undo XE "Undo"  key. You can now undo up to 100 actions in Excel (as of Excel 7.)
Putting More than One line in a Cell XE "Cell" 
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Type Alt key+Enter to break the text into two lines within a cell.

Creating a Spreadsheet

Starting at A1, type this:

Note: No data is ever added to a spreadsheet until you do one of these things:

· Press the Enter key

· Press the Tab key

· Click on the green check mark in the Formula Bar.

· Press an arrow key

Editing a Spreadsheet

Columns XE "Columns"  and rows XE "rows" 
· Place the pointer on the separator line between two columns and double-click. This will automatically make the column as wide as the widest item in the column. Or... you can drag a line to make it wider.

· You can drag the row separator to change any row height.

· If you see a row of pound signs in a cell (####), it means the column is too narrow to contain the data.

· Click the letter bar XE "bar"  on the top of any column to highlight the whole column.

· Click the number box on the left of any row to highlight the whole row.

AutoFit XE "AutoFit" 
Select the entire column, then click on Columns XE "Columns"  in the Format Menu, then choose AutoFit XE "AutoFit"  Selection. This will format the column to be as wide as the widest item in it.

Using AutoFill XE "AutoFill" 
· AutoFill XE "AutoFill"  refers to the handle on the lower right-hand corner of any cell (or group of cells), and which allows Excel to figure out what should go into adjoining cells.

· Type January in a cell. Place the pointer on the AutoFill XE "AutoFill"  handle and drag across several rows XE "rows" . Type the number 1 in another cell and do the same thing.

· Type the number 1 in a cell, number 2 in the next cell, select them both and AutoFill XE "AutoFill" .

Creating Your Own AutoFill XE "AutoFill"  Lists

Guidelines

· Entries must be 80 characters or fewer

· Total number of characters must be 2,000 characters or fewer

· Excel will ignore entries consisting of numbers, error values, or formulas

Creating an AutoFill XE "AutoFill"  List from Data Already in a Spreadsheet

1. Select the Cells containing the data you want

2. Choose Options from the Tools Menu

3. Click the Custom Lists tab

4. Click the Import button in the lower-right corner of the tab. The list will appear in both the Custom Lists and List Entries list boxes.

5. Click OK
Typing in a Custom AutoFill XE "AutoFill"  List

1. Click Options… from the Tools menu

2. Click the Custom Lists tab

3. Select New List
4. Type your entries, pressing the Enter key after each entry

5. Click Add
6. Click OK
Tools

· Move the mouse pointer onto any button, and you’ll see a small description box.

· Right-clicking shows you a selection of things you can do with whatever you’re pointing to.

· Right-clicking on the toolbar, on any blank section, gives you a toolbar pop-up menu. All displayed bars are marked with a checkmark ((). 

· Clicking on the Help menu gives you a variety of help descriptions.

· Clicking on any item, then clicking on the pointer with the question mark on it, will give you a Help screen appropriate for that item.

· Use the Examples and Demos and Quick Preview items on the Help Toolbar.

Sorting XE "Sorting" 
To sort a spreadsheet by the contents of one column, click on any cell in that column and click on either the Sort Ascending or Sort Descending buttons. The data in the other columns will follow.

Using Formulas XE "Formulas" 
Sometimes, you don’t want raw data in a cell, you want a formula instead. Using formulas requires that you click in the cell you want to put the formula that produces the desired results, and then figure out which values in the worksheet you want calculated. Finally, you apply formatting to clarify what the figures represent, such as dollars or percents.

· The most important thing to remember about calculations is that they start with an equal sign XE "equal sign"  (=). This tells Excel that the next information is a formula rather than data or a label.

· You must not put any spaces in a formula, or you will get the error message #VALUE! XE "#VALUE!"  in the cell. 

· Enter the values first, then formulas. Creating a formula based on cells that will contain numbers at a later date will give you an error message.

· First, enter an equal sign XE "equal sign"  (=). Then enter a cell reference, then enter an operator (+, -, *, /) then another cell reference. For example, A1+B1+C1+D1.

Mathematical Operators XE "Mathematical Operators" :

*  Multiplication

/  Division

+  Addition

-  Subtraction

· When you enter a formula, the cell contains the formula, but displays the results. However, at the same time you will see the formula itself in the formula bar XE "bar"  at the top of the spreadsheet. Changing the contents of a cell that supplies a formula with data will make the formula update immediately.

Using the Function XE "Function"  Wizard XE "Function Wizard" 
Click on the Function XE "Function"  Wizard XE "Function Wizard"  and look at the functions you can use.

Using AutoSum XE "AutoSum" 
The AutoSum XE "AutoSum"  button (() will add up a row or column automatically. Click on the cell in which you want the total, then click on the AutoSum button. Excel will assume you want to sum the cells above it, if there are numbers in those cells, or the cells to the left if there aren’t. 

Formatting XE "Formatting"  Your Spreadsheet

Formatting XE "Formatting"  Cells

· Click on a cell to activate it, then click on the Currency XE "Currency"  button ($) to format the cell in dollars.

· Click the Percent button to apply percent signs.

· Click the Comma button to apply commas to numbers.

· You can also increase or decrease the decimal places by using the two buttons.

· Or… Select the cells you want to format, go to Format in the Menu bar XE "bar" , click Cells…, and choose the formatting you want from there 

Absolute XE "Absolute"  and Relative Addresses XE "Relative Addresses" 
When you click on a cell, you will see the “relative address”, such as C2, in the left side of the formula bar XE "bar" . Sometimes, you may want absolute addresses. These are marked by dollar signs: $C$1.
Using AutoFormat XE "AutoFormat" 
To format a spreadsheet, select the area XE "area"  of the spreadsheet you want to format, then click on the AutoFormat XE "AutoFormat"  dialog box. Then click outside the spreadsheet to see how you like the formatting you chose. Undo XE "Undo"  it if you don’t like the format, or simply go to another format in AutoFormat. Clicking the Options button gives you other formatting options.

Center XE "Center"  Across Columns XE "Columns" 
When you are formatting your spreadsheet, Excel provides a very handy button for titles. It is called Format Across Cells, and it looks like a small letter a with arrows pointing to the right and the left. This feature allows you to type in the title of your spreadsheet in any cell of the row where you will want it, and later format it to center across the spreadsheet. To use it, do the following:

1. Click on the cell that holds the text.

2. Highlight all the rows XE "rows"  across which you’ll want your header to center. 

3. Press the Center XE "Center"  Across Rows button.

Using Drawing Objects XE "Drawing Objects" 
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You may want to add a drawing object, to give your spreadsheet visual interest. You cannot include any formulas etc. in a drawing object, however. To add a drawing object, first click on the Drawing Toolbar XE "Drawing Toolbar" . You can get to this either by going to the View Menu, then clicking on Toolbars XE "Toolbars" , then inserting a ( next to the Drawing Toolbar; or right-click on the toolbar. Or click on the button with a square, circle and triangle on it. This is the Drawing button, and it will activate the Drawing toolbar. Now do one of the following:

· If you want to create a box with text, choose the Text Box, which looks like a piece of paper with lines on it. You should see a small cross on the sheet; click where you want one corner of the text box to go, then drag till you have the object you want. When you finish, the object will still be selected.

· If you want a circle or other object without text, click on any of the other drawing objects and create them in the same way.

· If you want to edit a drawing object, click once on its edge. You will see a border with “handles” on the corners and sides. You can enlarge the object or change its shape by “pulling” with the mouse on these handles. Or you can delete the object by pressing delete. You can also click on the Format menu, then click on Format Object, and change a variety of features on the object.
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The latest versions of Excel allow you to crop, tilt, rotate, insert Word Art, use AutoShapes, and all the rest of the advanced graphics functions that Word allows.

Using Print XE "Print"  Preview XE "Print Preview" 
It is always critical to preview your chart XE "chart"  or spreadsheet before printing it. To do so, click on the button that looks like a magnifying glass, or click on Print XE "Print"  Preview XE "Print Preview"  in the File menu.

You will now see your spreadsheet the way it will actually print. If you want to make changes (and you almost always will), you can do most of them from here. At the top of the Print XE "Print"  Preview XE "Print Preview"  screen are buttons which will do several functions for you.

The Next and Previous buttons allow you to preview other pages in your document. 
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The Page Setup button allows you to choose either Portrait or Landscape orientation. It also allows you to Scale your document, either larger or smaller. You can change the Margins by specifying measurement, or you can drag and drop to change them. You can also center your document both vertically and horizontally. In Header XE "Header"  and Footer XE "Footer" , you can add custom headers and footers, change the defaults, or have no headers and footers at all. In Sheet, you can choose not to print gridlines, or you can decide to print the row and column headings. You can set the print area XE "area" , which means that you can print only part of a spreadsheet without actually deleting anything. To get back to your original, press Close. 

Set Print XE "Print"  Area XE "Set Print Area" 
If you simply press the Print XE "Print"  button, or the Print Command in the File menu, Excel will by default print every part of the spreadsheet you have worked on. This normally makes sense, but sometimes you may have accidentally input a character somewhere on the spreadsheet and Excel thinks it is the end of the spreadsheet. (If you want to know where the end is, press Control + End.)

Often you’ll want to up your spreadsheet so that only part of it will print, while the other parts don’t. To do this, go to Page Setup in the File Menu, and choose the Sheet tab.

You can also set up the Set Print XE "Print"  Area XE "Set Print Area"  button by selecting the area XE "area"  you want to set, going to File in the Menu bar XE "bar" , and selecting Print Area and Set Print Area. Remember that this area will be all that’s printed until you change the print area. (You can also set up the Print Area button on your toolbar by going to View, Toolbars XE "Toolbars" , and Customize.
Printing 

When you are ready to print, you can do it several ways. If you use Ctrl+P or Print XE "Print"  in the File menu, you will see a dialogue box. If you click on the Print button on the toolbar, it will simply send the document to the printer. The dialogue box allows you to print a selection, selected sheets, an entire workbook, selected pages, and one or more copies.

Charts Workshop

Quick Overview: Creating a Chart XE "Chart"  Using the Chart Wizard

1. Type in the spreadsheet above. Use the AutoFill XE "AutoFill"  button to insert June and July.

2. Format the Headings by highlighting the cells and Centering Across Columns XE "Columns" .

3. Format the data by highlighting the data only and clicking on the Currency XE "Currency"  button.

4. Select cell C10 and press the AutoSum XE "AutoSum"  (() button. This will give you a sum for Column c. Use the AutoFill XE "AutoFill"  button to sum the other two columns.

5. Select cell C12 and click the Function XE "Function"  button. Click the Average XE "Average"  function. Use the AutoFill XE "AutoFill"  button to generate averages for the other two columns. 

6. Select cells B4:F8.

7. Locate and click the ChartWizard XE "ChartWizard"  button on the toolbar.  

8. The Chart XE "Chart"  Wizard will now appear. It will first ask you to choose the chart XE "chart"  type you want, listing the types and sub-types you can choose from. For now, stick with the highlighted type, which is the default Column chart. Click Next.

9.  You will now see the dialogue box showing you the Chart XE "Chart"  Source Data, which should show you the cells you already selected. You can change the source cells if necessary. You can also choose whether your data is ordered by rows XE "rows"  or by columns; try both to get an idea of the difference. Click Next.

10. Next you’ll see the Chart XE "Chart"  Options box, letting you type the chart XE "chart"  and axes titles.

11. Next you’ll see the Location box, allowing you to put your chart XE "chart"  either on a new Worksheet or on the same page as your data. You can’t click Next again; you’re done. Click Finish.

When you use the Chart XE "Chart"  Wizard, your data is automatically classified into data series XE "data series"  and categories. For this chart XE "chart" , the rows XE "rows"  become the data series XE "series"  and the column headings become categories. Categories XE "Categories"  are the labels that appear along the x-axis, XE "axis"  or the horizontal axis. The bars on the chart represent the data series. If you want the columns to become the data series and the row headings to be categories, you can rerun ChartWizard XE "ChartWizard"  and change this. You can add labels, axis titles, and a chart title to further clarify your chart data.  he first column and first row of your data are usually assigned as the legend XE "legend"  text and category axis labels. You can specify another row or column if you want. For all but pie XE "pie"  and doughnut charts, you can also add category and value axis titles to further explain your categories or values.

Note: While you’re in the Chart XE "Chart"  Wizard, you can also go backward at any time if you change your mind about the previous decisions you’ve made. You can also click Finish at any time if you want to accept all the default values.

Important Basics for Creating Charts

Embedded XE "Embedded" /Stand-alone

A chart XE "chart"  can be located either on the same page as its data (embedded chart), or on a separate page. A chart is a graphic object and thus can be placed anywhere, including on top of other objects or data.

Definitions

· A data series XE "data series"  is a set of values you want to chart XE "chart" . Each value is a data point XE "data point" . If you want to plot XE "plot"  a company’s sales revenue for the past decade, for instance, the data series XE "series"  is that of sales revenue values. 

· Categories XE "Categories"  allow you to arrange, or organize, the values in a data series XE "data series" . In a chart XE "chart"  that plots the changes in a value over time, a time-series XE "series"  chart, the categories are always the time intervals. Sometimes the difference between a data series and a category can be confusing. The key distinction is this: the data series the set of values you’re plotting, and the categories are the headings under which the values are arranged.

Hint: If you can’t distinguish the data series XE "data series"  from the categories, answer the question “What am I plotting” with one word. That word will almost always be the data series XE "series" .

· The X axis, XE "axis"  or horizontal axis, XE "axis"  plots the categories, while the Y axis, XE "axis"  or vertical axis, XE "axis"  provides the values. The data series XE "data series"  will also typically be the legend XE "legend" . The top Y values will by default be the largest value in the list. Excel will by default look at the columns and rows XE "rows"  in the data to determine which are categories and which are values. If there are more columns than rows, or an equal number, it will use columns as categories. If there are more rows, it will choose them as categories.

· The axis is the horizontal, vertical or backwards line on the chart XE "chart"  which form the boundaries of the chart and contain the scale against which data plots. The category axis is the horizontal or x-axis, XE "axis"  the value axis is the vertical or Y-axis, XE "axis"  and the z-axis is the backwards or forwards axis which is used to show the third dimension on 3-D XE "3-D"  charts. Axes XE "Axes"  for bar XE "bar"  chars are reversed. Pie charts XE "Pie charts"  have no axes.)

· The Chart XE "Chart"  Wizard button starts the Chart Wizard, which guides you through the creation of a chart XE "chart"  step-by-step.

· The Legend XE "Legend"  is a guide that explains the symbols, patterns, or colors used to differentiate data series XE "data series" . The name of each data series XE "series"  is used by default as a legend XE "legend"  titles. The legend can be moved anywhere on a chart XE "chart" .

· A Marker XE "Marker"  is an object that represents a data point XE "data point"  in a chart XE "chart" . Bars, pie XE "pie"  wedges, and symbols are examples of markers. All the markers that belong to the same data series XE "data series"  appear as the same shape, symbol, and color. In 2-D line, bar XE "bar" , column  and XY scatter charts, Excel can use pictures drawn in Windows graphics programs as markers.

· The series XE "series"  formula is an external reference formula that tells Excel where to look on a specific worksheet to find the data for a chart XE "chart" .

· Text can be created, moved, edited, etc. anywhere on a chart XE "chart" .

· Toolbar: A special toolbar is available with charting tools.

· Tip. A box that identifies the object that the mouse pointer is pointing to.

Excel 97 Note: a new option in Excel 97 allows you to attach a data table to a chart XE "chart" , as shown below. This is an easy and effective way to provide the visual impact of a chart and the detailed information of a table simultaneously. The appended table is linked to the worksheet data so that its values change if you change the values in the source worksheet. To do this:

1. Click on the chart XE "chart"  to select it

2. Click on the chart XE "chart"  with the right mouse button

3. Click Chart XE "Chart"  Options…
4. Select Data Table
5. Check the options you want

6. Click OK
Rules for Creating Charts

· When you create a chart XE "chart" , each row or columns of data from the worksheet makes up a separate category called a data series XE "data series" . Each individual value within the row or column is a data point XE "data point" .

· When Excel examines the data you selected, the program assumes that the Category XE "Category"  (X) axis runs along the longer side of the selection. If the selection is square or wider than it is tall, Excel assumes that the category labels run across the top row of the selection. If the selection is taller than wide, Excel assumes that the category labels run down the left column of the selection.

· Excel assumes that labels in cells along the short side of the selection should be used as titles in the legend XE "legend"  for each data series XE "data series" . If only one data series XE "series"  exists, Excel uses this label to title the chart XE "chart" . If you select more than one data series, Excel uses the labels in these cells to title the legend.

· If the contents of the cells that Excel wants to use as category labels are numbers, not text or dates, Excel assumes that these cells contain a data series XE "data series"  and plots the graphs without category (X) labels, numbering each category instead.

· If the contents of the cells that Excel wants to use as series XE "series"  labels are numbers, not text or dates, then Excel assumes that these cells are the first data points in each of the data series XE "data series"  and assigns the names Series 1, Series 2, etc. 
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Parts of a Chart XE "Chart" 
1. The chart XE "chart"  is the entire area XE "area"  inside the window, including the chart itself and all related elements such as text, axes, or series XE "series"  markers.

2. The plot XE "plot"  area XE "area"  is the area in which Excel plots data.

3. The x-axis, XE "axis"  or Category XE "Category"  Axis, and the y-axis, XE "axis"  or Value XE "Value"  Axis, are the reference points for plotting data in a chart XE "chart" .

· The category axis refers to the horizontal or x-axis.

· The Value XE "Value"  axis refers to the vertical or y-axis.

· Note: in bar XE "bar"  charts this layout is reversed. In pie XE "pie"  charts there are no axes.

4. The chart XE "chart"  title is automatically placed at the top of a chart and centered.

5. The legend XE "legend"  describes the data series XE "data series"  being plotted. It displays the markers or patterns used as a data marker in the chart XE "chart" , followed by the corresponding data series XE "series"  name.

6. Tickmarks XE "Tickmarks"  are small lines intersecting the axes that help you distinguish one category of data from another.

7. Series markers XE "Series markers"  are the graphic elements that make up your data plot XE "plot" . Different types of charts use different kinds of makers to plot data. For example, column charts user vertical bars to show each data point XE "data point" , while line charts and scatter chars use small squares.

8. Gridlines XE "Gridlines"  are lines that extend from the axis across the plot XE "plot"  area XE "area" . They help guide the eye from the data marker to the corresponding value or category on the axis.

9. Text boxes XE "Text boxes"  can be added to any position in the chart XE "chart" .

Arrows XE "Arrows"  can be placed in the chart XE "chart"  to call attention to information or connect unattached text to a data series XE "data series" .

Plotting a Multiple Selection

Plotting a multiple selection refers to creating a chart XE "chart"  when you have other rows XE "rows"  or columns on a worksheet between the rows or columns you want to plot XE "plot" , or you want to plot a collapsed outline without plotting the hidden rows or columns, or when you want to plot only port of a row or column. Plotting a multiple selection allows you to use data in separate portions of the worksheet (non-contiguous XE "contiguous" , or non-touching, data.)

1. Select the columns and rows XE "rows"  that are together.

2. Press the Control Key.

3. Select the non-contiguous XE "contiguous"  text. 

4. Continue as usual to create the chart XE "chart" .

Creating a Chart XE "Chart"  Automatically

If you’re in a hurry and can use default values, you can select the data and press F11 to create a chart XE "chart" . (Press Alt+F1 if you don’t have an F11 key.) Note: you can only create a chart on a separate page this way, not an embedded chart. Excel will create a new page for it as the first worksheet.

Changing Chart XE "Chart"  Types and Formats

Excel allows you to change all the elements of your chart XE "chart" . To do so, right-click on the chart and you’ll get a drop-down menu of the elements you can change.

Moving XE "Moving"  a Chart XE "Chart"  on the Page

You can only move the chart XE "chart"  when you’ve clicked it and it’s selected as an object.

Standard Chart XE "Chart"  Types 

· Column Charts XE "Column Charts" ( Includes 2-D and 3-D XE "3-D"  charts.

· Bar Charts XE "Bar Charts" (Same as column, but sideways. 

· Line Charts(Compare trends over even time intervals. If you’re plotting data points at uneven intervals, use an XY (scatter) chart XE "chart" , as described below. Includes 3-D XE "3-D"  charts, also called ribbon charts. Note: In 2-D line charts, you can drag a point to a new position, and you’ll change the corresponding value in the worksheet.

· Pie charts XE "Pie charts"  (compare the sizes of the parts to the whole. In a 3-D XE "3-D"  pie XE "pie" , you can pull the “pieces” out. Note: if you try to create a pie chart XE "chart"  using more than one series XE "series"  of data, it will use the first series and ignore the rest.

· XY (Scatter XE "Scatter" ) Charts(compares trends over uneven time or measurement intervals plotted on the category axis. Use scatter charts when you must plot XE "plot"  data in which the independent variable is recorded at uneven intervals, or the category data points are specified in uneven increments. For example, survey data plotted with responses on the value axis, XE "axis"  and ages on the category axis, XE "axis"  can reveal opinion clusters by age. Used for scientific and engineering data.

· Area Charts XE "Area Charts" (Compares the continuous change in volume of multiple data series XE "data series" . It sums the data from all the individual series XE "series"  to create the top line that encloses the area XE "area" , giving you an impression of how different series contribute to the total volume. 

· Doughnut Charts XE "Doughnut Charts" (Similar to pie XE "pie"  charts, but they compare the sizes of pieces in more than one whole unit.

· Radar Charts XE "Radar Charts" (Shows the relationships between individual data series XE "data series" , and between a specific series XE "series"  and the whole of the other series. Difficult to read and interpret. 

· Surface Charts XE "Surface Charts" (Like topographical maps, showing high and low points along a surface. They are an excellent way to visually locate high and low points resulting from two changing variables.

· Bubble Charts XE "Bubble Charts" . This chart XE "chart"  allows you to represent three variables on a two-dimensional surface. The first two variables are plotted against the x axis and y axis, XE "axis"  similar to an XY (scatter) chart. The third variable is represented by the size of the bubble.
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· Stock XE "Stock"  Charts. These chars are used to display stock prices over time. You can display high, low, and closing prices; open, high, low, and closing prices; volume, high, low, and closing prices; and volume, open, high, low, and closing prices. When you select one of the sub-types that include volume, two value axes are created, one for volume represented by columns, and one for prices, depicted with vertical lines.

· Cylinder XE "Cylinder" , Cone XE "Cone" , and Pyramid XE "Pyramid"  Charts. These charts are variations on 3-D XE "3-D"  column and bar XE "bar"  charts, adding visual impact but not information.

Using Custom Chart XE "Chart"  types

There are 19 built-in custom chart XE "chart"  types, which are based on the standard types but enhanced with custom formatting and display settings. Go to the Custom Types tab of the Chart XE "Chart"  Type dialog box.

Creating User-Defined Custom Types

To create a custom chart XE "chart"  types, you essentially create a chart from scratch formatted the way you want, and then use it as a template for a custom chart type. Do this:

1. Activate the chart XE "chart" 
2. Choose Chart XE "Chart" , then Chart Type, and select the Custom Types tab.

3. Select the User-Defined option in the Select From area XE "area" . The dialog box now appears.

4. Click Add. The Add Custom Chart XE "Chart"  Type dialog box appears

5. Type a name for the new custom type in the Name box, and type a description in the Description box.

6. Click OK. The new type will now appear in the Custom Types, User-Defined option.

7. To delete the custom chart XE "chart"  type, select the type in the Chart XE "Chart"  Type list and click Delete. 

Adding a New Data Series to an Existing Chart XE "Chart" 
Embedded XE "Embedded"  Chart XE "Chart" :

· Select the cells containing the new data series XE "data series" .

· Drag the selected cells into the embedded chart XE "chart"  area XE "area" .

· Release the mouse button.

Chart XE "Chart"  on Separate Worksheet:

1. Select the new data

2. Copy

3. Paste on top of the chart XE "chart" .

Adding Data with the Chart XE "Chart" , Add Data Command

When you are working with an embedded chart XE "chart"  that has been activated or with a chart on a chart sheet, you can add new data to the chart with the Chart XE "Chart" , Add Data command.

1. Activate the embedded chart XE "chart"  or the chart sheet you want to update.
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2. Click Chart XE "Chart"  in the Menu bar XE "bar" , then Add Data. The Add Data dialog box appears:

3. Select the worksheet that contains the data you want to add to the chart XE "chart"  by clicking the tab for the worksheet.

4. Select the data in the worksheet, just as you would select data in a worksheet when you first create a chart XE "chart" .

5. Include row and column headings in the selection if you want them to appear in the chart XE "chart" . The reference for this data range appears in the Range text box.

Or…

Type the cell references for the data you want in the Range edit box.

1. Click OK.

2. If the data you selected has the same layout as the original data used to create the chart XE "chart" , the data is added immediately to the chart. If Excel can’t figure out how it should go into the chart, the Paste Special dialog box appears. Specify the layout you want and click OK.

Adding Data from Multiple Worksheets

By choosing Chart XE "Chart" , Add Data, you can combine data from multiple worksheets into one chart XE "chart" :

1. Create a chart XE "chart"  from the worksheet data you want as the first series XE "series"  in the chart.

2. Choose Chart XE "Chart" , Add Data.
3. Activate a different worksheet.

4. Select a data series XE "data series" . Include labels if the original data selection includes labels.

5. Click OK.

6. Repeat steps 2-5 for each data series XE "data series"  you want to add to the chart XE "chart" .

Adding Data with the Edit Copy and Edit Paste Commands 

You can also copy the data you want to add to your chart XE "chart" , and simply paste it into the chart.

Adding Text to Your Chart XE "Chart" 
To do this, simply start typing anywhere on your chart XE "chart" , and then move the text you’ve typed wherever you want it. 

Modifying the Axes XE "Axes" 
When you build a chart XE "chart"  using the Chart XE "Chart"  Wizard, Excel automatically creates a Category XE "Category"  (X) axis and a Value XE "Value"  (Y) axis, XE "axis"  as well as a Z axis if you created a 3-D XE "3-D"  chart. You can remove any of the axes, change the labels, change titles, etc. To remove an axis, XE "axis"  for instance, do this:

1. Click Chart XE "Chart"  in the Menu bar XE "bar" 
2. Click Chart XE "Chart"  Options
3. Click the Options tab

4. Click the Axes XE "Axes"  tab

5. Clear the check box for the axis or axes you want to remove. Preview the chart XE "chart"  to verify your selection.

Inserting Data Labels XE "Data Labels" 
To insert data labels, do this:

1. Activate the chart XE "chart"  to which you want to add data labels.

2. Select the data point XE "data point"  or points to which you want to add labels. To select an entire data series XE "data series" , click any point in the series XE "series" . All data points in that series are selected, as indicated by squares that appear on each data point. To select an individual point, click a second time on that data point. To insert labels on all data points for all series, select any object in the chart XE "chart"  that is not a data point. For example, click outside the chart to select the entire chart.

3. Click Chart XE "Chart"  in the Menu bar XE "bar" , then Chart Options.

4. Click the one of these options: None, Show Value XE "Value" , Show Percent, Show Label, Show Label and Percent, or Show Bubble Sizes.
5. If you want the key from the legend XE "legend"  to be displayed along with the data value, select the Legend XE "Legend"  Key Next to Label option.

6. Click OK.

Inserting a Legend XE "Legend" 
If you didn’t create a legend XE "legend"  when you first created the chart XE "chart" , you can add one by choosing Chart XE "Chart"  from the Menu bar XE "bar" , Chart Options, the Legend XE "Legend"  tab, and Show Legend.

Changing Object Colors XE "Colors" , Patterns XE "Patterns" , and Borders XE "Borders" 
Note: The Fill Effect XE "Fill Effect"  dialog box is new to Excel 97. It lets you add very sophisticated fill effects to your charts. Excel lets you add gradients, textures, patterns or pictures to chart XE "chart"  bars, pie XE "pie"  slices and other chart objects. 

1. Right-click on a chart XE "chart"  object, and choose Format Data Series. 

2. Click on the Patterns XE "Patterns"  tab. 

3. Click on the Fill Effects XE "Fill Effects"  button. 

4. Click on the tab you want and choose the effect.

5. Click OK; then click OK again. 
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Aligning XE "Aligning"  and Rotating XE "Rotating"  Text

6. Select the object whose alignment you want to change.

7. Choose Format, Selected Object. Or, click the object with the right mouse button and select the Format command from the shortcut menu. Or, double-click the object to open the Format Title dialog box.

8. Select the Alignment tab.
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9. You’ll see this dialog box:

10. Select the alignment you want from the horizontal and vertical drop-down lists.

11. Drag the pointer in the Orientation box up or down to change the orientation of the text 

Or…

Specify a value in the Degrees box between 90 and –90 degrees

Or….
To quickly select a stacked orientation, reading top to bottom, click the box that has the word Text in it (next to the Orientation Gauge).

12. Click OK.

Rotating XE "Rotating"  a 3-D XE "3-D"  Chart XE "Chart"  by Dragging

1. Click at the tip of one of the axes.

2. Black handles appear at the end of all eight tips.

3. Drag one of the handles on the side close to you. Drag in the direction you want the chart XE "chart"  to rotate. Imagine that the chart is a sphere and you are dragging the mouse along the surface of this sphere. As you drag, a wire-frame outline of the chart depicts the chart’s orientation.

4. Release the mouse button when the outline appears to be oriented as you wish.

Using the 3-D XE "3-D"  View Command

Select any 3-D XE "3-D"  chart XE "chart"  with the right mouse button and choose 3-D View. You will get the 3-D View dialog box, which will allow you to adjust any or all of these items:

1. Elevation: Changes the height from which you see the chart XE "chart" . Normally you’ll want –90 to +90 degrees; pie XE "pie"  charts will be 10 to 80 degrees.

2. Rotation XE "Rotation" : rotates the chart XE "chart"  around the Z-axis. The range is from 0 to 360 degrees.

3. Perspective XE "Perspective" : controls the vanishing point or the sense of depth in the chart XE "chart" . Use a number between 0 and 100 to specify the ration of the front of the chart to its back.

4. Height XE "Height"  % of Base: Controls the height of the Z-axis as a percentage of the chart XE "chart"  width (X) axis. Enter a number between 5 and 500.

5. Right Angle XE "Angle"  Axes XE "Axes" : Freezes axis angles at 90 degrees. Perspective XE "Perspective"  is turned off.

Creating Combination XE "Combination"  Charts

1. Open the chart XE "chart"  from which you want to create the combination chart.

2. Select the data series XE "data series"  whose chat type you want to change.

3. Choose Chart XE "Chart" , Chart Type, or choose Chart Type from the chart XE "chart"  shortcut menu.

4. Select the type of chart XE "chart"  you want to use for the selected series XE "series"  in the Chart XE "Chart"  Type dialog box.

5. Click OK.

Creating Picture Charts

The new Fill Effects XE "Fill Effects"  dialog box, which you open from the Format Data Series dialog box, simplifies the procedure for replacing data makers with pictures in column, bar XE "bar" , area XE "area" , bubble, 3-D XE "3-D"  line, an d filled radar charts. You can use the Picture tab in the Fill Effects dialog box to select a graphic file that is stored on your computer and use it to replace the data markers for the selected data series XE "data series" . You can also use this command to fill the plot XE "plot"  or chart XE "chart"  areas with a graphic image. You can use file types including Window Metafile (.wmf), Windows Bitmap (.bmp), PC Paintbrush, and .gif files.

Printing Charts

If a chart XE "chart"  is embedded in a worksheet, it will print when you print the worksheet. If you want to print the chart alone, click to activate and print.

Note: You should always view anything in Excel in Print XE "Print"  Preview XE "Print Preview"  before you print it. You will almost always want to adjust something before printing.

Worksheet and Workbook Specifications

All the Microsoft applications provide a feature called Specifications. This gives you the real limitations sizes, no. of characters, etc., the application can handle. In the case of Excel, the importance of this is that all versions of Excel until Excel 97 limit the user to entering 255 or fewer characters in any one cell.
Worksheet and workbook specifications (Excel 97 Only)

	Feature
	Specification

	Maximum number of scenarios
	Limited by available memory; a summary report shows only the first 251 scenarios

	Maximum number of changing cells in a scenario
	32

	Maximum number of adjustable cells in Solver
	200

	Maximum number of named views in a workbook
	Limited by available memory, although the Custom Views dialog box lists only the first 256 views

	Number precision 
	15 digits

	Largest allowed positive number
	9.99999999999999E307

	Smallest allowed negative number
	-9.99999999999999E307

	Smallest allowed positive number
	1E-307

	Largest allowed negative number
	-1E-307

	Maximum number of iterations
	32,767 

	Maximum size of worksheet arrays
	6,553 elements

	Maximum number of colors in a workbook 
	56

	Maximum number of cell styles in a workbook
	4,000

	Maximum number of custom number formats
	Limited by available memory

	Maximum number of selected ranges 
	2,048 

	Maximum number of names in a workbook 
	Limited by available memory 

	Maximum number of arguments in a function 
	30

	Maximum number of nested levels of functions
	7

	Number of available worksheet functions 
	329

	Maximum number of custom functions
	Limited by available memory 

	Maximum number of windows in a workbook 
	Limited only by system resources 

	Maximum number of panes in a window 
	4 

	Maximum number of linked sheets 
	Limited by available memory

	Zoom range
	10 percent to 400 percent

	Maximum number of reports
	Limited by available memory 

	Maximum number of sort references
	3 in a single sort; unlimited when using sequential sorts

	Maximum number of undo levels
	16 (default)

	Maximum number of fields in a data form
	32

	Earliest date allowed for calculation
	January 1, 1900 (January 1, 1904, if 1904 date system is used)

	Latest date allowed for calculation
	December 31, 9999

	Maximum number of PivotTables on a sheet
	Limited by available memory

	Maximum number of items in a PivotTable
	8,000

	Maximum number of pages in a PivotTable
	8,000

	Maximum number of row or column fields in a PivotTable
	Limited by available memory

	Maximum number of page fields in a PivotTable
	256 (May be limited by available memory)

	Maximum number of data fields in a PivotTable
	256

	Maximum number of calculated item formulas in a PivotTable
	Limited by available memory to 255up to ct 


Saving XE "Saving"  and Backing Up XE "Backing Up"  Files

One of the most frustrating things that can happen to computer users is the loss of a file or data. This has been occurring a lot recently, probably because of the move. Construction, power outages, network moves, and high stress, are all hard on computers, computer users, and files. So here are a few suggestions.

· Backup files to a floppy disk. Whenever you complete anything, or whenever you get the chance, use Save As... in the File menu to save a backup file on a floppy disk. That way, whatever happens to your computer, the work you did is intact.

· Backup to your C drive as you work. Go to Save in the File menu, or use the Save icon on your toolbar to save your work regularly.

· Use the Automatic Save options in Excel.  Excel has some automatic save options similar to those found in Word. Do the following:

· Click on Tools
· Click on Add-Ins
· Click on the checkbox marked AutoSave.
· Click on OK.
Using Notes in Excel

The ability to add comments to an Excel worksheet is especially useful when several people are reviewing it. For example, suppose you commonly create worksheets that get sent to Sue. This time, the total really doesn’t look quite right to you. So you’d like Sue to take a good look at the numbers. Click your Total cell and choose Insert, Comment. When the Comment dialog box opens, type in your message to Sue and save the worksheet. You’ll notice that a small red triangle will appear in the upper-right corner of the cell that contains the comment. 

When Sue opens the worksheet, she will see the comment indicator. She can read the comment by simply moving the mouse cursor over the marked cell. To enter a response to your comment, she can right-click the cell and select Edit Comment. 

When Sue passes the file along to Harvey, he’ll see the marker and move the cursor over the cell. Now he can read both comments and add one of his own if he chooses.

Excel Helpful Hints

Foreign Currencies XE "Currencies" 
In all applications: 

· To make the symbol for the British Pound XE "Pound" , press the alt key and 0163 on the numeric keypad.

· To make the symbol for the Japanese Yen XE "Yen" , press the alt key and 0165 on the numeric keypad. ¥ £ (this is 14 point bold.)
In Word and PowerPoint: 

· Click Insert, then Symbol.

· In the Font box, click MS Line Draw.

· Choose the pound sign or the Yen XE "Yen"  sign. 

· The symbol will enlarge so you can see it better.

· Click Insert.

· Click Close.

· 
( ((this is 16 pt. bold, Times New Roman.)
· 
£ ¥  (12 point Garamond Three)
Center XE "Center"  Across Columns XE "Columns"  With Excel 97 

Migrating to Excel 97 has produced headaches for some of our readers, especially when they’re trying to use features that worked just fine in Excel 5 or Excel 95.

If you use both Excel 95 and Excel 97 you may have noticed that Excel 95’s Center XE "Center"  Across Columns XE "Columns"  button is labeled Merge and Center in Excel 97, and it produces a different effect.

However, you can still center across a selection in Excel 97. Clicking Excel 97’s Merge and Center XE "Center"  button actually performs two operations: It merges the selected cells into a single larger cell, and it horizontally centers whatever was in the upper-left cell. Note that it does not concatenate the data—contents of other cells are deleted. 

You can’t change this button’s function to get it to behave the way it used to, but you can still center the data in the cells you’ve selected. Highlight the cells you want to center, select Format, Cells; click the Alignment tab; select Center XE "Center"  Across Selection from the Horizontal drop-down box, and deselect the Merge cells box.
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